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NOTATIONAL CONVENTIONS AND GLOSSARY 

■ General notations 

 WARNING : A potentially hazardous situation which, if not avoided, could result 
in death or serious injury. 

 CAUTION : A potentially hazardous situation which, if not avoided, could result 
in minor injury or material damage. 
Material damage includes, but is not limited to, damage to related 
devices and facilities, and acquired data. 

— CAUTION — : Points where great care and attention is required when operating the 
device to avoid damage to the device itself. 

�: Additional points to be remembered regarding the operation. 

�: A reference to another section, chapter or manual. 

1, 2, 3 : Numbers indicate a series of operations that achieve a task. 

◆ : A diamond indicates a single operation that achieves a task. 

File: The names of menus, or commands displayed on the screen, and 
those of buttons of the instrument, are denoted with bold letters. 

File–Exit : A command to be executed from a pulldown menu is denoted by 
linking the menu name and the command name with a dash (–). 
For example, File–Exit means to execute the Exit command by se-
lecting it from the File menu. 

 
■ Mouse operation 

Mouse pointer: An arrow-shaped mark displayed on the screen, which moves with 
the movement of the mouse. It is used to specify a menu item, 
command, parameter value, and other items. Its shape changes ac-
cording to the situation. 

Click: To press and release the left mouse button. 

Right-click: To press and release the right mouse button. 

Double-click: To press and release the left mouse button twice quickly. 

Drag: To hold down the left mouse button while moving the mouse. 
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1 GENERAL 

The Automatic Serial Analysis Program consists of software to carry out automatic 
analysis continuously by combining different analysis programs with different 
measurement conditions. 
 
 

2 SPECIFICATIONS AND FEATURES 

The following are the specifications and features of the Automatic Serial Analysis 
Program. 

 
Analyses available: WDS Qualitative Analysis 

Map Analysis 
Line Analysis 
Quantitative Analysis (of unknown samples) 
EDS Qualitative Analysis (standard sample analysisis 
not possible) 
Optional Automatic Particle Analysis Program 

Number of automatic serial analysis conditions: 
Up to 100 sets of conditions can be stored 

Automatic serial analysis conditions that can be changed: 
EOS conditions 
EDS conditions 
Stage conditions (spot, line, and area) 
Printout conditions 
Selection of standard conditions for quantitative analysis 

Deleting, copying and moving of automatic serial analysis conditions: 
Possible 

Displaying processes in progress of automatic serial analysis: 
Possible 

Specifying accelerating voltage on/off after measurement: 
Possible 

Other: Data processing using quantitative, qualitative, map, or 
line analysis program is possible after measurement with 
automatic serial analysis program 
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3 PROGRAM COMPOSITION 

The automatic serial analysis program is included in the program hierarchy (Analysis in 
EPMA Main Menu) shown below. 
 

 Analysis 

Serial Analysis

File

Open Serial Dir…

Printout…

Condition

Input Condition…

Copy…

Move…

Delete…

Delete All…

Select All…

Unselect All…

Unselect stage each analysis…

Select range…

Unselect range…

Select all stage…

Unselect all stage…

Options

Matrix Input Mode (m)

ACCV Off after Measurements (o)

Measurement

One by One…

Preset…

Exit

Exit

Select stage each analysis…
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4 SERIAL AUTO ANALYSIS WINDOW 

The Automatic Serial Analysis Program is operated in the Serial Auto Analysis main 
window. 
 

4.1 How to Open Serial Auto Analysis Window 

1. Open the EPMA Main Menu on the computer display and then click on the 
Analysis icon to display the Analysis menu. 

��Refer to the instruction manual of the microanalyzer main unit for instructions 
on how to open the EPMA Main Menu.  

 

Fig. 1  EPMA Main Menu 
 
2. Select Serial Analysis from the Analysis menu. 

The Serial Auto Analysis main window opens as shown in Fig. 2.  

  
Fig. 2  Serial Auto Analysis main window 
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In this window, you find Serial Directory displaying the directory name of the serial 
analysis that is presently selected, No. of Analysis that displays the number of recorded 
serial analyses, Accv off after All Meas. which, if set, turns off automatically the 
accelerating voltage after serial analysis measurement, the Comments input box in 
which you can enter up to 40 characters, and the list of analysis-condition files for each 
sample.  
Up to 100 items for a serial analysis measurement can be stored. Each item can be 
highlighted by positioning the mouse pointer on the desired item and then clicking on it.  
��In Fig. 2, Serial number 1 is highlighted.  
Clicking on the Input button enables you to change the highlighted item or specify a 
new condition on the highlighted line. 
 

4.2 Menu Bar 
The menu bar of the Serial Auto Analysis main window of Fig. 2 has menus necessary 
for operation of the Automatic Serial Analysis Program. Clicking on any item displays a 
pull-down menu and makes the following operations available. 
 

4.2.1 File 
 

Object Function 

Open Serial Dir… Displays the Serial Analysis Dir. window (refer to Fig. 3) for operating 
the previously set conditions in the directory of the Automatic Serial 
Analysis Program. 

Printout… Prints the present conditions for automatic serial analysis. 

Exit Terminates the input of conditions for automatic serial analysis. 

 

4.2.2 Condition 
 

Object Function 

Input Condition… Displays the Serial Analysis Condition Input window (refer to Fig. 4) for 
entering and compiling automatic serial analysis conditions for the 
presently selected (highlighted) item. 
The Input button of the Serial Auto Analysis main window has the same 
function as the Input Condition… button. 

Copy… Copies automatic serial analysis conditions. 
Clicking on this button opens a window for copying. 

Move… Moves automatic serial analysis conditions. 

Delete… Deletes the selected automatic serial analysis conditions. 
Before deleting of the selected conditions is executed, a confirmation 
window appears. 

Delete All… Deletes all the automatic serial analysis conditions. 
Before executing, a confirmation window appears. 

Select All… Specifies Yes in the Meas. column for conditions of all the automatic 
serial analyses. 
Before executing, a confirmation window appears. 
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Object Function 

Unselect All… Specifies No in the Meas. column for conditions of all the automatic 
serial analyses. 
Before executing, a confirmation window appears. 

Select stage each 
analysis… 

Enables you to select the stage position on entering matrix conditions. 
Clicking on this object opens a window for selection of the stage position.

Unselect stage 
each analysis… 

Enables you to deselect the stage position on entering matrix conditions. 
Clicking on this object opens a window for deselecting the stage position.

Select range… Enables you to select the measurement range for entering matrix 
conditions. 
Clicking on this object opens a window for selecting measurement range.

Unselect range… Enables you to deselect the measurement range for entering matrix 
conditions. 
Clicking on this object opens a window for deselecting measurement 
range. 

Select all stage Selects all the stage positions for serial analysis conditions for entering 
matrix conditions. 

Unselect all stage Deselects all the stage positions for serial analysis conditions for entering 
matrix conditions. 

 

4.2.3 Options 
 

Object Function 

Matrix Input 
Mode (m) 

Enables you to specify which analysis is to execute at each point in a 
matrix of stage positions. In contrast, the usual setting enables you to 
specify stage conditions for each analysis method. 
However, this does not function for the map and line analyses. 

ACCV Off after 
Measurements (o) 

Specifies turning the accelerating voltage off after serial analysis 
measurement. 
The ACCV Off after Measurements (o) item on the Options menu has 
the same function as the Accv off after All Meas. button on the Serial 
Auto Analysis main window. 

 

4.2.4 Measurement 
 

Object Function 

One by One… Executes only the serial analysis measurements whose conditions are 
highlighted. 
Before executing, a confirmation window appears. 

Preset… Executes from the top the serial analysis measurements whose Meas. 
selection is Yes. 
Before executing, a confirmation window appears. 

 

4.2.5 Exit 
 

Object Function 

Exit Terminates the input of conditions for automatic serial analysis. 
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4.3 Objects in the Serial Auto Analysis window 
The following functions are available when you perform operations, displays, and entries 
for Automatic Serial Analysis. 
 

Object Function 

Serial Directory Displays the name of a directory in which the automatic serial analysis 
conditions presently selected are stored. 

No. of Analysis Displays the total number of automatic serial analysis conditions recorded 
in the directory being displayed. 

Accv off after All 
Meas. 

Specifies keeping the accelerating voltage on or turning it off after 
completion of automatic serial analysis. 

Input Selecting Input displays the Serial Analysis Condition Input window 
shown in Fig. 4, enabling you to enter serial analysis conditions. 

Comments Displays the comments attached to the Serial Directory file being 
displayed. 

Meas. Yes/No Selects Yes or No for doing measurement. 

No Displays the serial number for automatic serial analysis that is allocated in 
ascending order. 

Analysis Displays the following types of analysis. 
Quali (W): WDS qualitative analysis 
Quali (E): EDS qualitative analysis only for JXA-8200 
Line: Line analysis 
Map: Map analysis 
Quant: Quantitative analysis 
Particle: Optional Automatic Particle Analysis Program 

Meas Elements Displays the following types of measurement signals. 

W: The number of conditions for WDS qualitative scan or 
elements in WDS quantitative analysis 

E: The number of conditions for elements in EDS 
quantitative analysis 

I: Number of IMS or CAL elements 
COMPO: Signals of COMPO (composition image of the 

backscatterd electron image) 
TOPO: Signals of TOPO (topographic image of the backscatterd 

electron image)  
SEI:  Signals of SEI (secondary electron image) 
AUX: AUX (exteral) signals 

Group/Sample Names of group/sample in which measurement data are stored. 

Stage Displays the number of recorded stage positions. 

ACC [KV] 
P. Current [A] 

Displays the accelerating voltage and probe current. 
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5 OPERATIONS 

This chapter describes the procedures for automatic serial analysis to be operated from 
the Serial Auto Analysis window. 
 

5.1 Specifying the Directory of Automatic Serial Analysis 
Conditions 

First, create a directory in which you want to save serial analysis conditions. If you have 
saved multiple serial analysis conditions in each directory, you can choose from them the 
best analysis conditions for a sample to measure. 

 
If the directory has already been created, specify it. It is possible to delete an unnecessary 
directory.  
1. Select File from the menu bar shown in the Serial Auto Analysis main 

window (refer to Fig. 2). 
The File menu opens. 

2. Select Open Serial Dir… from the File menu. 
The Serial Analysis Dir. window opens as shown in Fig. 3. 

 

 

Fig. 3  Serial Analysis Dir. window 
 
3. Select the desired directory, in which automatic serial analysis conditions are 

saved, from the directory list in the Serial Analysis Dir. window. 
If you want to create a new directory, click on the New button. Then enter a name 
for the new directory in the Serial Analysis Dir. window. 
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If you want to delete a stored directory, click on the directory in the Serial Analysis 
Dir. window. It will be highlighted. Then click on the Delete button. 

 
—— CAUTION ———————  

When a directory is deleted, the files saved in it will be deleted, too. 
If there are files you do not want to be deleted in a directory, you 
should move the files to a different directory before deleting the 
directory. 

 
It is possible to change the name of a directory by using the Rename button, or to 
print the directory list by using the Print button. To do this, click on the desired 
directories in the Serial Analysis Dir. window, as stated above.  
The amount of disk space in use and the amount of free disk space are displayed in 
kilobytes under the directory list. 

4. Click on the OK button. 
All the automatic serial analysis condition files saved in the specified directory will 
be displayed in the list of analysis-condition files on the Serial Auto Analysis main 
window shown in Fig. 2. 
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5.2 Determining Automatic Serial Analysis Conditions 
After specifying a directory of automatic serial analysis conditions, as described in the 
previous section, create a condition file or edit a condition file saved in the directory, 
specifying analysis conditions and analysis position, in accordance with the procedure 
below.  
1. Specify an automatic serial analysis condition file in the Serial Auto Analysis 

main window shown in Fig. 2. 
��If you want to edit a condition file stored in the specified directory, select the 

desired condition file number from the condition file list in Fig. 2. The selected 
file number line will be highlighted. 

��If you want to create a new condition file to be stored in the specified directory, 
move the mouse pointer to the unrecorded file number line in the list of analy-
sis-condition files (the fifth line in Fig. 2) and click on it. The selected file number 
line will be highlighted. 

2. Click on the Input button. 
��Alternatively select Condition–Input Condition… from the menu bar. 
  The Serial Analysis Condition Input window opens as shown in Fig. 4.  

 

Fig. 4  Serial Analysis Condition Input window 
 
3. Specify measurement conditions by operating the following buttons in the 

Serial Analysis Condition Input window. 
 

��� and � buttons 
Clicking on these buttons in the upper right corner highlights the condition file line 
above or below the presently highlighted line. 

 
��Measurement Kind 

Select the desired Measurement Kind. 
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Clicking on the Condition Load button or Condition Change button loads or 
changes the measurement conditions, respectively.  
You select from the following measurement kinds. 

 
Button Function 

Quali (W) WDS Qualitative Analysis 

Line Line Analysis 

Map Map Analysis 

Quant Quantitative Analysis 

Quali (E) EDS qualitative Analysis 

Particle Optional Automatic Particle Analysis 

 
��Measurement Kind–Condition Load button 

Click on the Condition Load button in the Serial Analysis Condition Input win-
dow.  
The Quant Condition File Load window opens as shown in Fig. 5. 

 

Fig. 5  Quant Condition File Load window 
 

Selecting From Present Condition Files loads the present measurement conditions. 
If you have changed the measurement conditions and want to use them for the serial 
analysis measurement, open the Condition File Load window and click on this 
Condition Load button.  
Selecting From Stored Condition Files enables you to select a stored measurement 
condition file from the serial analysis condition list. 
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If you click on the Check button, you can confirm the presently selected conditions.  
��The stage conditions cannot be loaded with the Condition Load button. They 

are determined either by the conditions stored under the Group/Sample names 
or by the conditions specified by using Stage Condition in the Serial Analysis 
Condition Input window of Fig. 4.  

The following conditions are loaded for each measurement. 
 

Button Function 

Quali (W) WDS Qualitative Analysis 
WDS spectrometer conditions, EOS conditions and printout conditions

Line Line Analysis 
Element conditions, EOS conditions, EDS conditions and printout 
conditions 

Map Map Analysis 
Element conditions, EOS conditions, EDS conditions and printout 
conditions 

Quant Quantitative Analysis 
Element (including CAI elements) conditions, correction calculation 
conditions, standard sample names, EOS conditions, EDS conditions, 
WDS–EDS measurement order and printout conditions 

Quali (E) EDS Qualitative Analysis 
EDS conditions, EOS conditions and printout conditions 

Particle Optional Automatic Particle Analysis 
Element conditions, EOS conditions, EDS conditions, particle analysis 
conditions and printout conditions 

 
��Measurement Kind–Condition Change button 

Click on the Condition Change button in the Serial Analysis Condition Input 
window. 
The Change Measurement conditions window opens as shown in Fig. 6. 

 

Fig. 6  Change Measurement Conditions window (Quantitative Analysis) 
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The following conditions can be changed for each measurement. 
 

Button Function 

Quali (W) WDS Qualitative Analysis 
EOS conditions and printout conditions 

Line Line Analysis 
EOS conditions, EDS conditions and printout conditions 

Map Map Analysis 
EOS conditions, EDS conditions and printout conditions 

Quant Quantitative Analysis 
EOS conditions, EDS conditions, standard sample names and printout 
conditions 

Quali (E) EDS Qualitative Analysis 
EOS conditions and EDS conditions 

Particle Optional Automatic Particle Analysis 
EOS conditions and EDS conditions 

 
��Group/Sample button 

Click on the Group/Sample button in the Serial Analysis Condition Input window. 
You can select the Group/Sample name.  
The selected Group/Sample name will appear in the display box to the right of the 
button.  

��Stage Condition button 
Click on the Stage Condition button in the Serial Analysis Condition Input window. 
A dialog box appears. In this dialog box, you can select or edit analysis positions 
(stage positions).  
The dialog box is the same as the Stage Condition window that is in each analysis 
program. Dialog boxes that are displayed differ in their contents depending on the 
type of analysis. Therefore, when entering information in them, refer to the descrip-
tion of the Stage Condition window in the instruction manual of the respective 
analysis program. 
The number in the display box to the right of the Stage Condition button represents 
the number of analysis points that have been turned on in the Stage Condition 
window.  

��Apply button 
Click on the Apply button in the Serial Analysis Condition Input window. 
The selected or edited measurement conditions will be stored.  

4. Select Measurement—One-by-One… or —Preset… from the menu bar in the 
Serial Auto Analysis main window of Fig. 2. 

A window for starting the measurement will appear. 
5. Click on the Acquire button in the window for starting the measurement. 

Measurement starts. 
When the measurement mode of the Stage Condition window of each analysis 
program is One-by-One, only the analysis items highlighted in the Serial Auto 
Analysis window will be measured. 
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When the measurement mode is Preset, the analysis items whose Meas.–Yes/No 
buttons are set to Yes will be measured in succession.  
The Serial Analysis Measurement window is displayed during measurement, as 
shown in Fig. 7. It tells you the progress of an automatic serial analysis such as 
Analysis Kind, Group Name, Sample Name, Stage Number and Accumu 
(accumulation) Number. If any error should happen, it will be displayed in this 
window.  
��You cannot close the Serial Analysis Measurement window during automatic 

serial analysis. 
��The approximate disk space that is used for storing automatic serial analysis 

conditions will be shown. If the disk does not have sufficient free space, a 
warning message will be displayed. 

 

 

Fig. 7  Serial Analysis Measurement window 
 

To interrupt measurement, click on the Measurement Stop button. 
To stop accumulation, turn on the Accum. Stop button by clicking on it. 
To turn off the accelerating voltage, select Accv Off by clicking on it. 

6. Click on the Print-out button. 
The information under Measurement Log Message will be output to the printer. 
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5.3 Determining Automatic Serial Analysis Matrix Conditions 
You can use matrix function in Automatic Serial Analysis. Using this function facilitates 
specifying different analysis methods for a sample. However, it is only possible for point 
analysis in WDS Qualitative and Semi-Quantitative Analysis, EDS Qualitative and 
Semi-Quantitative Analysis, and Quantitative Analysis. You cannot use this for Map 
Analysis, Line Analysis and Particle Analysis. 
 

5.3.1 Opening Serial Auto Analysis matrix window 

��Select Options—Matrix Input Mode (m) from the menu bar in the Serial Auto 
Analysis main window (refer to Fig. 2). 

The Serial Auto Analysis matrix window appears as shown in Fig. 8.  
In this window, stage numbers very in the vertical direction, while analysis kinds 
and conditions very in the horizontal direction. You can determine conditions for 
stage position, and analysis kind and conditions. 

 

 

Fig. 8  Serial Auto Analysis matrix window 
 

5.3.2 Storing analysis position reference 

1. Click on the Group/Sample button at the upper left corner of the condition list 
in the Serial Auto Analysis matrix-specifying window. 

A window appears. 
2. Specify the desired group and sample whose stage-position conditions are to 

be used as references. 
If the specified reference Group/Sample has stage conditions for point analysis, its 
recorded stage position numbers will be displayed at the left end of the list. 
If the specified Group/Sample has no stage condition for point analysis, a stage 
position input window opens, and in it you store stage positions necessary for 
reference. 
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5.3.3 Entering analysis kind 

1. Click on the Input button in the Serial Auto Analysis matrix window. 
The Serial Analysis Condition Input window opens. 

2. Specify measurement kinds and analysis conditions, and the names of 
Group and Sample in which to save measurement data in this window. 
��If you do not specify a file in which to save measurement data, the measurement 

data will be saved in the Group and Sample that you specified in the analysis 
position reference. 

��If you want to specify a file in which to save measurement data, be sure to avoid 
using the same file name for measurement kinds such as qualitative analysis and 
quantitative analysis and analysis conditions as the file name. If the file name is 
the same, click on the Store Group/Sample button; then create another file with a 
different file name to save measurement data. 
��Before changing a file name to save measurement data, if there are any stage 

conditions for point analysis in the selected file, a warning message appears, 
asking whether or not to overwrite. 

 

5.3.4 Specifying Yes or No for measurement kinds and analysis conditions 

��Select Yes or No by clicking on the Yes/No button for analysis execution as 
shown in Fig. 9. 

Measurement kinds and analysis conditions that you specified Yes will be executed 
and those that you specified No will not be executed.  

 

Yes/No 
buttons 

 

Fig. 9  Yes/No buttons 
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5.3.5 Condition menu for Serial Auto Analysis matrix window 

The Condition menu of the Serial Auto Analysis matrix window is as follows. 
 

Item Function 

Select stage each 
analysis… 

Selecting this allows you to set the presently selected stage for 
measurement kind and analysis conditions to Yes. 
Selecting this opens a dialog box. Enter the desired stage range, and then 
click on the OK button. 

Unselect stage 
each analysis… 

Selecting this allows you to set the presently selected stage for 
measurement kind and analysis conditions to No. 
Selecting this opens a dialog box. Enter the desired stage range, and then 
click on the OK button. 

Select range… Selecting this allows you to specify the range to select for the number of 
measurement kind and analysis conditions, and the stage numbers. 
Selecting this opens a dialog box. First specify the number of 
measurement kind and analysis conditions to select, next enter the range 
of stage to select, and then click on the OK button. 

Unselect range… Selecting this allows you to specify the range to unselect for the number 
of measurement kind and analysis conditions, and the number of stage. 
Selecting this opens a dialog box. First specify the number of 
measurement kind and analysis conditions to unselect, next enter the 
range of stage to unselect, and then click on the OK button. 

Select all stage Selecting this allows you to set all the presently displayed stages for 
measurement kind and analysis conditions to Yes. 
Selecting this opens a dialog box. Click on the OK button in it. 

Unselect all stage Selecting this allows you to set all the presently displayed stages for 
measurement kind and analysis conditions to No. 
Selecting this opens a dialog box. Click on the OK button in it. 
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6 CAUTIONS 

6.1 Stage Conditions 

6.1.1 Specifying the same stage conditions as the stored ones 

If you specify the stage number that is already used in an identical Group/Sample name 
and in an identical analysis, the later measurement data is kept and the former 
measurement data is deleted. However, if you do the same operation in a different 
analysis, no problem occurs even if you specify an identical stage number. 
 

6.1.2 Specifying stage conditions in automatic serial analysis 

Only the specified stage numbers are saved as automatic serial analysis conditions. The 
conditions of the stage numbers are not saved. Therefore, if you change the stage 
conditions for the specified number using an analysis program, measurement proceeds 
under the changed conditions. 
 

6.2 Changing Measurement Conditions during Automatic Serial 
Analysis 

Respective measurement conditions are automatically loaded and updated during 
automatic serial analysis. If you change measurement conditions during measurement, 
the system may not operate properly. Therefore, never make such a change. 
 

6.3 Changing Automatic Serial Analysis Conditions during 
Automatic Serial Analysis 

In automatic serial analysis, measurement condition files are automatically loaded 
immediately before each measurement, and the system is automatically set to the loaded 
measurement conditions. If you change the preset automatic serial analysis conditions 
during automatic serial analysis, the system may not operate properly. Therefore, never 
make such a change. 
 

6.4 When Window Does Not Close Despite Selecting Exit 
If the Serial Auto Analysis main window of Fig. 2 does not close even when you click on 
the Exit button in the window, close the Serial Analysis Measurement window of Fig. 7. 

 
After you carry out a quantitative analysis, close the x_text window which displays the 
result of the quantitative analysis. 
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7 APPENDIX 

Given below is reference information for using the Automatic Serial Analysis Program. 
 

■ Directory structure of software to be used in JXA-8100/8200 series 
electron probe microanalyzers 

 
��Basic structure 

 
xl

For respective 
measurement 

conditions 

.line .qlw .map .qnt .std .serial .mescnd .pana GROUP .end

For automatic 
serial analysis

For automatic 
particle 
analysis 

SAMPLE 

For loading 
conditions  

 
��Directories for loading and saving measurement conditions 

 
xl

.line

.mescnd

.qlw .map .qnt .std .ed  
 
��Directories for loading and saving automatic serial analysis conditions 

xl

.serial

gs.def Dir1

Serial. order
1. ser 
2. ser 

Dir3 Dir4

…
…

.

Dir2

 

 
 

��Dir1 to Dir4 are directories for automatic serial analysis. 
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